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TOPIC 1: INTRODUCTION TO ICTS   DURATION: 28 PERIODS 

1. Definition 

ICT (Information and Communication Technology) refers to all technologies used to create, 
store, manage, transmit, and share information. It combines computing, 
telecommunications, and digital technologies to improve communication and access to 
data. 

2. Components of ICT 

1. Hardware: Physical devices such as computers, smartphones, printers, routers, and 
storage media. 

2. Software: Programs and applications that run on hardware, such as operating systems, 
word processors, spreadsheets, and browsers. 

3. Network Infrastructure: Internet, intranets, LANs, and cloud services that connect 
devices and allow communication. 

4. People / Users: Individuals who operate ICT tools, create content, and manage 
systems. 

5. Data / Information: The content that is processed, stored, or communicated using ICT 
tools. 

3. Importance of ICT 
• Education: Enables e-learning, research, and digital collaboration. 

• Business: Improves productivity, communication, record keeping, and online 
marketing. 

• Healthcare: Supports telemedicine, patient records, and diagnostics. 

• Governance: Facilitates e-government, public services, and data management. 

• Daily Life: Powers banking, shopping, social media, and communication. 

4. Characteristics of ICT 
• Speed: Allows fast processing and transfer of information. 

• Accuracy: Reduces errors in data handling. 
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• Connectivity: Enables global communication and collaboration. 

• Storage: Can store large amounts of data digitally. 

• Automation: Reduces manual work through software and intelligent systems. 

 

ICT TOOLS AND THEIR DESCRIPTIONS 
ICT tools are devices, software, and systems used to create, store, process, transmit, and 
manage information. They can be classified into hardware, software, and networking tools. 

1. Hardware Tools 
Physical devices used to interact with digital information. 

• Computers / Laptops: Used for processing data, creating documents, programming, 
and internet access. 

• Smartphones / Tablets: Portable devices for communication, browsing, and mobile 
applications. 

• Printers / Scanners: Produce physical copies of documents and digitize paper 
documents. 

• Storage Devices: USB drives, external hard drives, CDs, and cloud storage for storing 
and transferring files. 

• Networking Devices: Routers, modems, and switches that connect devices to networks 
and the internet. 

2. Software Tools 
Programs that allow users to perform specific tasks on hardware. 

• Word Processors: Create and edit text documents (e.g., Microsoft Word). 

• Spreadsheets: Handle calculations, tables, and data analysis (e.g., Microsoft Excel). 

• Presentation Software: Create slideshows for communication (e.g., PowerPoint). 

• Database Management Systems: Store and manage structured data (e.g., Microsoft 
Access). 
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• Web Browsers: Access information on the internet (e.g., Google Chrome, Firefox). 

3. Networking and Communication Tools 

• Email Applications: Send and receive messages electronically (e.g., Gmail, Outlook). 

• Video Conferencing Tools: Conduct virtual meetings (e.g., Zoom, Microsoft Teams). 

• Social Media Platforms: Share information and collaborate online (e.g., Facebook, 
LinkedIn). 

• Cloud Services: Store and share files online securely (e.g., Google Drive, OneDrive 

5. Examples of ICT Tools 
• Computers & Laptops: For word processing, programming, and data analysis. 

• Smartphones & Tablets: For communication, internet access, and mobile apps. 

• Printers & Scanners: For producing physical copies and digitizing documents. 

• Internet & Networking Devices: For online research, communication, and cloud 
storage. 

• Software Applications: MS Office, Google Suite, Adobe tools, and database 
management systems. 

 

6. Benefits of ICT 
• Improves efficiency and productivity. 

• Facilitates instant communication and collaboration. 

• Enhances learning and access to information. 

• Supports decision-making with accurate and timely data. 

• Enables innovation and creative problem-solving. 

 

USES OF ICT IN DAILY SOCIETY: 
Information and Communication Technology (ICT) play a vital role in our everyday life by 
transforming the way people perform tasks, communicate, and access information. 
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Through the use of computers, mobile phones, the internet, and digital systems, ICT has 
made work easier by reducing manual effort, faster by enabling instant processing and 
communication, and more efficient by improving accuracy and productivity. Activities 
that once required a lot of time, physical movement, and paperwork can now be completed 
within minutes using digital tools. 

In homes, schools, offices, hospitals, businesses, and government institutions, ICT supports 
daily operations by simplifying complex tasks and enhancing decision-making.  

 

1. ICT in Education 
ICT in education involves using digital tools and platforms to improve teaching, learning, 
and school management. These tools help deliver lessons online, support self-paced 
learning, and make administration more efficient. 

ICT Tool / 
Platform 

Use in Education Benefits Ways of Maintaining 

Google 
Classroom / 
Moodle 

Share lessons, 
assignments, quizzes, 
and track student 
progress 

Saves time, organizes 
learning materials, 
allows remote learning 

Keep software updated, 
use strong passwords, 
backup course data 
regularly 

Zoom / 
Microsoft 
Teams 

Conduct live online 
classes, webinars, 
and virtual group 
discussions 

Enables remote 
learning, supports 
collaboration, allows 
interaction with 
teachers & peers 

Update to latest version, 
secure meeting links, 
ensure stable internet 
connection 

Khan 
Academy / 
Duolingo 

Self-paced learning in 
various subjects 

Personalized learning, 
improves 
understanding, 
accessible anywhere 

update apps, manage 
login credentials, 
monitor app 
subscriptions 

Interactive 
Whiteboards 

Display multimedia 
lessons, diagrams, 
and interactive 
activities 

Makes lessons 
engaging, supports 
visual learning, 
encourages 
participation 

Clean regularly, avoid 
harsh chemicals, 
perform software 
updates 

E-Libraries 
/ Online 
Resources 

Access textbooks, 
journals, videos, and 
research materials 

Expands access to 
information, supports 
research, saves cost on 
physical books 

Maintain stable 
subscriptions, backup 
downloaded materials, 
update access credentials 
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Quizlet / 
Online 
Quizzes 

Practice exercises, 
revision tests, and 
instant assessments 

Immediate feedback, 
enhances retention, 
easy tracking of 
student progress 

Regularly update quiz 
sets, monitor user 
access, keep devices 
charged and functional 

Virtual 
Reality / AR 
Tools 

Virtual labs, field 
trips, or immersive 
simulations 

Makes learning 
interactive, enhances 
understanding of 
complex concepts 

Handle VR devices 
carefully, store safely, 
update software and 
firmware regularly 

Student 
Information 
Systems 

Record attendance, 
grades, and manage 
school 
administration 

Improves 
administrative 
efficiency, accurate 
record-keeping, easier 
reporting 

Backup data frequently, 
restrict access to 
authorized personnel, 
update security patches 

 

2. ICT in Business 
ICT in business uses digital tools and platforms to manage operations, communication, 
marketing, and decision-making. It enhances productivity, efficiency, and market reach. 

ICT Tool / 
Platform 

Use in Business Benefits Ways of Maintaining 

ERP Systems 
(SAP, Oracle) 

Manage 
operations, 
finance, HR, and 
supply chains 

Improves efficiency, 
integrates processes, 
reduces errors 

Regular updates, 
secure login 
credentials, backup 
data, monitor system 
performance 

CRM Software 
(Salesforce, 
Zoho) 

Track customer 
interactions, sales, 
and marketing 
campaigns 

Improves customer 
service, personalizes 
engagement, increases 
loyalty 

Update software, 
secure access, train 
staff, perform 
periodic backups 

E-Commerce 
Platforms 
(Shopify, 
Amazon) 

Sell products 
online, advertise, 
and reach 
customers 
worldwide 

Expands market reach, 
operates 24/7, increases 
sales 

Monitor site security, 
backup website data, 
update software and 
plugins regularly 
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Cloud 
Computing 
(AWS, Azure) 

Store data 
securely, enable 
remote access 

Reduces IT costs, 
improves collaboration, 
ensures data safety 

Manage access rights, 
use strong 
passwords, regularly 
review storage usage 

Collaboration 
Tools (Teams, 
Slack) 

Facilitate 
teamwork, 
meetings, and file 
sharing 

Supports remote work, 
improves 
communication, boosts 
productivity 

Update apps, secure 
login, monitor user 
activity, ensure stable 
internet 

Data Analytics 
/ BI (Power 
BI, Tableau) 

Analyze trends, 
optimize 
operations, and 
make informed 
decisions 

Supports strategic 
decisions, identifies 
opportunities, improves 
efficiency 

Update data sources, 
validate data 
integrity, secure 
access, backup 
dashboards 

Digital 
Marketing 
Tools 

Advertise and 
promote products 
online 

Reaches wider 
audience, cost-effective, 
measurable results 

Keep account 
credentials secure, 
update campaigns, 
monitor analytics 

 

3. ICT in Finance & Banking 
ICT in finance and banking involves using digital technologies for transactions, data 
management, financial analysis, and customer services. These tools improve speed, 
security, and efficiency. 

ICT TOOL / 
PLATFORM 

USE IN FINANCE 
& BANKING 

BENEFITS WAYS OF 
MAINTAINING 

Online 
Banking / 
Mobile Apps 

Transfer funds, pay 
bills, check 
balances, view 
statements 

Convenient, 
accessible 
anytime/anywhere, 
reduces need to visit 
bank branches 

Update apps regularly, 
use strong passwords, 
monitor transactions 
for fraud 

Core Banking 
Systems 
(Finacle, 
Temenos) 

Manage accounts, 
loans, deposits, 
and customer data 
across branches 

Improves efficiency, 
centralizes data, 
reduces errors 

Backup data daily, 
update software, 
restrict access, 
monitor system 
performance 
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Electronic 
Payment 
Systems (POS, 
Digital 
Wallets) 

Accept electronic 
payments from 
customers 

Speeds up 
transactions, 
cashless, reduces 
handling errors 

Secure devices, update 
software, perform 
regular audits 

Financial 
Management 
Software 
(QuickBooks, 
Sage, Tally) 

Track income, 
expenses, payroll, 
budgets, and 
generate financial 
reports 

Saves time, accurate 
record-keeping, 
supports decision-
making 

Backup financial data, 
update software, 
control user access 

Automated 
Teller 
Machines 
(ATMs) 

Withdraw/deposit 
money, transfer 
funds without 
visiting a branch 

24/7 access, reduces 
queues, convenient 
for customers 

Regular maintenance, 
secure physical 
location, software 
updates 

Data Analytics 
& BI (Power 
BI, Tableau, 
SAS) 

Analyze trends, 
detect fraud, assess 
risks, forecast 
markets 

Supports informed 
decisions, improves 
risk management, 
identifies 
opportunities 

Backup dashboards, 
secure login, update 
data sources regularly 

Blockchain / 
Cryptocurrency 
Platforms 

Secure digital 
transactions and 
decentralized 
records 

Transparent, tamper-
proof, reduces fraud, 
speeds up cross-
border payments 

Keep wallets and keys 
secure, update 
software, validate 
transactions regularly 

CRM Software 
(Salesforce, 
Zoho CRM) 

Track customer 
interactions and 
manage 
relationships 

Enhances customer 
satisfaction, 
improves loyalty, 
personalizes services 

Update client records, 
secure access, perform 
periodic system 
maintenance 

 

4. ICT in Agriculture 
ICT in agriculture involves using digital tools, software, and mobile platforms to improve 
farming practices, monitor crops, manage resources, and access market information. These 
tools help farmers increase productivity, reduce costs, and make informed decisions. 

ICT TOOL / 
PLATFORM 

USE IN 
AGRICULTURE 

BENEFITS WAYS OF 
MAINTAINING 
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Agricultural 
Drones 

Monitor crop 
health, detect pests, 
assess soil 
conditions 

Saves time, 
increases accuracy, 
identifies problems 
early 

Charge batteries, store 
safely, update software 
regularly 

GPS-enabled 
Machinery 

Precision planting, 
automated 
harvesting 

Reduces waste, 
improves efficiency, 
increases yield 

Calibrate sensors 
regularly, maintain 
equipment, update 
GPS maps 

Soil & 
Climate 
Sensors 

Measure soil 
moisture, 
temperature, and 
weather conditions 

Enables precision 
irrigation and 
fertilization 

Protect from harsh 
weather, clean sensors, 
replace batteries as 
needed 

Farm 
Management 
Software 

Record crops, 
manage finances, 
track inputs and 
outputs 

Organizes farm data, 
improves planning, 
increases 
productivity 

Backup data, update 
software, restrict 
access 

Mobile 
Advisory 
Apps 

Provide weather 
forecasts, market 
prices, and expert 
advice 

Helps farmers make 
informed decisions, 
reduces risks, 
increases income 

Update app regularly, 
secure login 
credentials, monitor 
notifications 

Digital 
Marketplaces 

Sell produce online, 
access buyers and 
suppliers 

Expands market 
reach, improves 
income, reduces 
middlemen 

Monitor platform 
security, update 
listings, backup 
transaction data 

IoT-based 
Irrigation 
Systems 

Automate watering 
based on soil 
moisture and 
weather data 

Saves water, reduces 
costs, increases yield 

Regularly inspect 
sensors, clean pipes, 
update system 
software 

 

5. ICT in Healthcare 
Brief Description: 
ICT in healthcare (eHealth) uses digital tools and platforms to deliver medical services, 
manage patient data, monitor health, and educate communities. ICT improves efficiency, 
access, and quality of healthcare. 
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ICT TOOL / 
PLATFORM 

USE IN 
HEALTHCARE 

BENEFITS WAYS OF 
MAINTAINING 

Telemedicine 
Platforms 

Conduct remote 
consultations, follow-
ups, and diagnostics 

Expands access to 
care, saves time, 
reduces travel 

Ensure software 
updates, secure patient 
data, stable internet 
connection 

Electronic 
Health Records 
(EHR/EMR) 

Store patient history, 
lab results, treatment 
plans 

Improves accuracy, 
reduces 
duplication, 
enables data 
sharing 

Backup records, 
restrict access to 
authorized personnel, 
update software 

Mobile Health 
(mHealth) Apps 

Track fitness, 
medication, 
appointments, and 
health education 

Encourages self-
care, improves 
adherence, 
provides reminders 

Update app, secure 
login credentials, 
monitor data privacy 

Wearable 
Devices 

Monitor heart rate, 
blood pressure, 
glucose, or activity 

Enables continuous 
monitoring, early 
detection of issues 

Charge devices, clean 
sensors, update 
firmware/software 

Health 
Information 
Systems (DHIS2) 

Collect and analyze 
health data for 
planning and 
reporting 

Supports decision-
making, improves 
surveillance, 
enhances resource 
allocation 

Backup data regularly, 
restrict access, update 
software 

AI Diagnostics & 
Decision Support 

Assist in diagnosing 
diseases, predicting 
outbreaks 

Improves accuracy, 
speeds up 
diagnosis, supports 
doctors 

Update AI models, 
monitor performance, 
secure patient data 

 

ICT in Transport: 
ICT tools are used in transportation to improve efficiency, safety, and management. They 
include GPS and navigation systems for tracking vehicles, traffic management systems to 
control flow, online ticketing platforms for bookings, fleet management software for 
logistics, and electronic toll collection for faster payments. These tools help reduce travel 
time, prevent congestion, enhance security, and ensure smooth operations. 

ICT Tool / 
Platform 

Use in 
Transport 

Benefits Ways of Maintaining 
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GPS & 
Navigation 
Systems 

Guide drivers 
and track 
vehicles 

Reduces travel time; 
prevents getting 
lost; improves fleet 
tracking 

Regular software updates; 
calibrate devices; secure 
mounting in vehicles 

Traffic 
Management 
Systems 

Monitor and 
control traffic 
flow 

Reduces congestion; 
improves road 
safety 

Update software; maintain 
sensors and cameras; 
ensure uninterrupted power 
supply 

Online Ticketing 
/ Booking 
Platforms 

Book tickets for 
buses, trains, 
airlines 

Convenience; 
reduces queues; 
faster service 

Regular system updates; 
secure servers; data backup 

Fleet 
Management 
Software 

Schedule 
deliveries and 
track cargo 

Efficient logistics; 
reduces operational 
costs 

Update software; secure 
login credentials; regular 
hardware checks 

Electronic Toll 
Collection 
Systems 

Automate toll 
payments 

Speeds up 
payments; reduces 
congestion at tolls 

Maintain sensors and RFID 
readers; software updates; 
regular inspections 

Vehicle Tracking 
Systems 

Monitor vehicle 
location and 
driver behavior 

Enhances security; 
improves 
operational 
efficiency 

Check device connectivity; 
update tracking software; 
regular 
battery/maintenance checks 

Communication 
Tools (Radio, 
Mobile Apps) 

Coordinate 
drivers, 
dispatchers, and 
control centers 

Faster decision-
making; improves 
safety 

Regular device 
maintenance; secure 
communication channels; 
software updates 

7. ICT in Governance 
Brief Description: 
ICT in governance (e-government) uses digital tools to deliver public services, manage 
administration, enhance transparency, and engage citizens. ICT increases efficiency, 
accessibility, and accountability in government operations. 

ICT TOOL / 
PLATFORM 

USE IN 
GOVERNANCE 

BENEFITS WAYS OF 
MAINTAINING 
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E-Government 
Portals 

Provide online 
services for taxes, 
licenses, benefits, and 
registrations 

Convenient, 24/7 
access, reduces 
bureaucracy 

Update portal 
regularly, secure login, 
backup databases 

Digital ID 
Systems 
(Aadhaar, e-
Identity) 

Identify citizens, 
enable access to 
services 

Increases accuracy, 
reduces fraud, 
simplifies service 
delivery 

Secure database, 
restrict access, update 
system 

Geographic 
Information 
Systems (GIS) 

Support planning, 
mapping, and disaster 
management 

Improves planning, 
resource allocation, 
and crisis response 

Update maps and 
layers, maintain 
servers, backup data 

Online Voting / 
Consultation 
Systems 

Facilitate citizen 
participation and 
decision-making 

Encourages 
transparency, 
engagement, and 
democracy 

Secure voting 
platform, monitor 
activity, perform 
regular updates 

Electronic 
Document 
Management 

Store, retrieve, and 
track government 
documents 

Reduces paper use, 
speeds up processes, 
improves record-
keeping 

Backup documents, 
restrict access, update 
software 

E-Procurement 
Systems 

Manage tenders, bids, 
and government 
purchases digitally 

Reduces corruption, 
saves time, 
improves efficiency 

Monitor transactions, 
update software, 
secure access 

 

 

ICT LITERACY 

1. Definition 
ICT Literacy is the ability to effectively use Information and Communication Technology 
(ICT) tools to access, evaluate, create, and communicate information. It involves not just 
knowing how to use devices and software but also understanding their applications in real-
life contexts. 

2. Components of ICT Literacy 
1. Knowledge of ICT Tools: 
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o Understanding hardware (computers, smartphones, printers) and software (Word 
processors, spreadsheets, browsers). 

2. Digital Skills: 

o Ability to use ICT tools for tasks such as typing, creating documents, sending 
emails, browsing the internet, and data management. 

3. Information Literacy: 

o Ability to find, evaluate, and use information effectively and responsibly. 

4. Communication Skills: 

o Using ICT tools to communicate, collaborate, and share information online 
(emails, video calls, social media, cloud storage). 

5. Problem-Solving and Creativity: 

o Using ICT to solve problems, create content, or develop applications. 

6. Ethical and Safe Use: 

o Understanding digital safety, cybersecurity, privacy, and responsible behavior 
online. 

 

3. Importance of ICT Literacy 
• Education: Enhances learning through digital resources, research, and online 

collaboration. 

• Business & Work: Improves productivity, communication, and access to global 
markets. 

• Personal Life: Facilitates online banking, shopping, and social communication. 

• Information Access: Helps in retrieving, evaluating, and using information 
efficiently. 

• Innovation: Empowers users to create digital content, applications, and solutions. 

4. Skills Developed Through ICT Literacy 
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• Operating devices like computers, tablets, and smartphones. 

• Using office applications (Word, Excel, PowerPoint). 

• Managing files and folders effectively. 

• Searching and evaluating online information critically. 

• Communicating through email, messaging apps, and online platforms. 

• Protecting data through passwords, backups, and safe online practices. 

5. Examples of ICT Literacy in Practice 

• A student creating a project report using Microsoft Word, inserting tables and charts 
from Excel, and submitting it via email. 

• A business worker managing customer records on a database and analyzing data 
using spreadsheets. 

• Using the internet to research a topic, evaluating sources, and presenting findings in 
a multimedia presentation. 

1. UNDERSTANDING ICT COMPONENTS 
An ICT system is made up of hardware, software, networks, people, and data. To form a 
working system, these components must interact efficiently. 

Key ICT Components: 

1. Hardware: Physical devices such as computers, servers, printers, scanners, routers, 
and mobile devices. 

2. Software: Programs and applications that control hardware and allow users to 
perform tasks (e.g., operating systems, word processors, databases). 

3. Networks: Communication links like LAN, WAN, Wi-Fi, or the Internet that connect 
devices and enable data sharing. 

4. Data: Information stored, processed, and transmitted by the system. 

5. People: Users who input data, operate the system, and make decisions. 

2. Connecting ICT Components to Form a Working System 

1. Input → Processing → Output → Storage 
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o Input devices (keyboard, scanner, mouse) feed data into the system. 

o Processing units (CPU, servers) interpret and process the data using software. 

o Output devices (monitors, printers, speakers) display or present the results. 

o Storage devices (hard drives, cloud servers) save data for future use. 

2. Network Integration 

o Devices and servers are connected via LAN, WAN, or Wi-Fi, enabling 
communication and resource sharing. 

o Example: A school’s ICT system connects teacher computers, student tablets, and 
the server through a network to access a learning management system. 

3. Software Coordination 

o Applications like databases, ERP, or CRM interact with hardware and networks to 
perform specific tasks. 

o Example: In banking, core banking software communicates with servers, ATMs, 
and mobile apps to process transactions. 

4. User Interaction 

o People operate input/output devices, run applications, and make decisions based 
on system outputs. 

o Example: Farmers using mobile advisory apps enter farm data, which is processed 
on servers and returns advice. 

5. Security & Maintenance 

o Firewalls, antivirus software, and access control systems protect the system. 

o Regular maintenance ensures all components function together efficiently. 

3. Example: A Working ICT System in a School 
Component Role 

Computers/Tablets Input, processing, and accessing digital resources 

LMS Software Organizes lessons, tracks progress, processes data 

Network (LAN/Wi-Fi) Connects all devices to the server and internet 
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Server/Cloud Stores lessons, student records, and course materials 

Printers/Projectors Output devices for printing or displaying lessons 

Teachers/Students Users who interact with the system 

Security Software Protects data and prevents unauthorized access 

 

Working: 

1. Teacher uploads lesson content via LMS → stored on server. 

2. Students access content through tablets over Wi-Fi. 

3. Students complete assignments → processed by the server. 

4. Teacher views results and gives feedback → printed or displayed on screen 
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BOOTING 
Booting is the process by which a computer starts up and loads its operating system (OS) 
after being powered on. The term comes from "bootstrapping," which refers to starting a 
system with minimal instructions that then load the rest of the system. 

Booting involves initial hardware checks, loading system software, and preparing the 
computer for user interaction. There are two main types of booting: 

1. Cold Boot (Hard Boot): 

o Occurs when the computer is started from a completely powered-off state. 

o All hardware and software initialization steps are performed. 

2. Warm Boot (Soft Boot): 

o Occurs when the system restarts without turning off the power (e.g., using Restart). 

o Some hardware checks may be skipped, making the process faster. 

Steps in the Booting Process 

1. Power-On / POST (Power-On Self-Test): 

❖ When the computer is powered on, the BIOS/UEFI firmware initializes hardware 
components like CPU, RAM, and storage. 

❖ Performs diagnostic tests (POST) to ensure hardware is functional. 

❖ If errors are detected, the boot process may halt with error messages. 

2. Bootloader Loading: 

❖ BIOS/UEFI locates the bootloader from the system’s storage. 

❖ Bootloader is responsible for loading the operating system kernel into memory. 

❖ Examples: Windows → bootmgr, macOS → boot.efi, Linux → GRUB. 

3. Kernel Loading: 

❖ The OS kernel is loaded into RAM. 

❖ Initializes system resources and hardware drivers needed for the OS to function. 

4. System Initialization: 

❖ OS starts core services, background processes, and prepares the environment. 
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❖ Examples: Windows → Session Manager and Win32 subsystem; macOS → launchd; 
Linux → systemd or init. 

5. User Login and Desktop Loading: 

❖ The login manager prompts for user credentials. 

❖ Upon successful login, the desktop environment is loaded (e.g., Windows Explorer, 
macOS Finder, Linux GUI). 

6. Boot Complete: 

❖ The computer is now fully operational and ready for use. 

❖ All background services continue running while the user interacts with the system. 
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BOOTING FLOW CHART IN DIAGRAM 
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STARTING AND SHUTTING DOWN ICT DEVICES 
Starting and shutting down ICT devices involves the proper procedures used to power on or 
off devices like computers, smartphones, printers, and routers. Proper startup ensures that 
the device initializes correctly, loading its operating system or firmware without errors. 
Proper shutdown safely closes applications, saves data, and prevents hardware or software 
damage. 

Devices may also experience forced shutdowns, which are used when a device becomes 
unresponsive, typically by holding the power button. This carries risks such as data loss or 
corruption. Unexpected power loss, such as during power outages, can also cause damage 
to files, hardware, or active processes, highlighting the importance of backup power 
solutions like UPS and careful handling. 

 

EXPLANATION OF STARTING AND SHUTTING DOWN VARIOUS 

ICT DEVICES 

1. Computers (Desktops & Laptops) 
Scenario Starting Procedure Shutting Down 

Procedure 
Notes / Precautions 

Proper 
Startup 

Press the power 
button; wait for 
BIOS/OS to load. 

Use OS shutdown 
option (Start → Power 
→ Shut down). 

Ensures files are saved 
and OS isn’t corrupted. 

Forced 
Startup (after 
crash) 

Press and hold power 
button for a few 
seconds to restart. 

Press and hold power 
button until it powers 
off; then restart 
normally. 

Use only if 
unresponsive; risk of 
data loss. 

Unexpected 
Power Loss 

N/A (device turned 
off abruptly) 

N/A Risk of file corruption 
or hardware issues; 
consider using a UPS. 
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2. Smartphones & Tablets 
Scenario Starting Procedure Shutting Down 

Procedure 
Notes / Precautions 

Proper 
Startup 

Press and hold power 
button until logo 
appears. 

Press and hold 
power button → 
select “Power off” 
option. 

Saves battery and avoids 
OS errors. 

Forced 
Startup 

Press and hold power + 
volume buttons (device-
specific) 

Same as above, or 
force restart if 
frozen. 

Only if device is 
unresponsive. 

Unexpected 
Power Loss 

N/A N/A Can cause app crashes or 
minor data loss; backup 
regularly. 

3. Printers 
Scenario Starting 

Procedure 
Shutting Down 
Procedure 

Notes / Precautions 

Proper 
Startup 

Plug in → press 
power button → 
wait for 
initialization. 

Press power button 
→ wait for printer 
to finish tasks. 

Avoid interrupting printing; 
prevents hardware damage. 

Forced 
Shutdown 

Unplug or hold 
power button 

N/A Only in emergencies; may 
cause print job loss. 

Unexpected 
Power Loss 

N/A N/A Could corrupt print queue; 
restart printer properly once 
power returns. 
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4. Routers / Modems 
Scenario Starting Procedure Shutting Down 

Procedure 
Notes / Precautions 

Proper 
Startup 

Plug in → press power button 
if present → wait for LEDs to 
stabilize. 

Press power 
button (if any) → 
unplug if needed. 

Prevents network 
issues. 

Forced 
Shutdown 

Unplug immediately N/A Only if unresponsive; 
avoid frequent abrupt 
shutdowns. 

Unexpected 
Power Loss 

N/A N/A Can reset network 
sessions; consider 
surge protectors. 

 

 

Key Points Across All Devices: 
1. Always prefer proper shutdown to avoid file corruption or hardware damage. 

2. Forced shutdowns should be last resort. 

3. Unexpected power loss can damage data and components; use UPS or backup power 
when possible. 

4. Wait for devices to fully boot or power down before turning off accessories (USB 
devices, external drives). 

FILES AND FOLDER MANAGEMENT 
 

1. Definition 

• File: A file is a collection of related data or information stored on a storage device with 
a unique name and often a file extension that identifies its type (e.g., .docx for Word 
documents, .jpg for images). 

• Folder (Directory): A folder is a virtual container used to organize files and other 
folders (subfolders) in a hierarchical structure. Folders help manage data efficiently 
and prevent clutter. 
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2. Importance of Files and Folders 
1. Organization: Keeps data structured for easy access. 

2. Data Management: Simplifies storing, retrieving, and sharing information. 

3. Efficiency: Saves time by avoiding file search confusion. 

4. Security: Files and folders can be protected using passwords or access permissions. 

5. Backup & Recovery: Easier to backup organized folders and prevent data loss. 

6. Collaboration: Supports teamwork by allowing multiple users to access organized 
directories. 

3. Characteristics 
Files: 

• Have a name and extension (type identifier). 

• Store digital data: text, images, videos, software, or databases. 

• Can have attributes: read-only, hidden, system file. 

• Must reside in a folder or directory. 

Folders (Directories): 
• Containers for files or subfolders. 

• Can have hierarchical structures for organization. 

• Can have attributes: hidden, read-only. 

• Named to reflect contents for easy identification. 

4. Actions Performed on Files and Folders 
1. Creating: Make new files or folders to store data. 

2. Opening/Viewing: Access the content of a file or folder. 

3. Renaming: Change the name for better identification. 
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4. Copying/Moving: Duplicate or relocate to another location. 

5. Deleting: Remove files/folders when no longer needed. 

6. Searching: Find files/folders by name, type, or keyword. 

7. Backing Up: Save copies to prevent data loss. 

8. Changing Properties/Permissions: Adjust attributes like read-only, hidden, or access 
rights. 

9. Organizing/Structuring: Group files logically into folders and subfolders for easy 
management. 

 

5. Practical Examples 
Directory Structure Example: 

Documents 

 ├─ School 

 │   ├─ Assignments 

 │   └─ Notes 

 └─ Personal 

     ├─ Photos 

     └─ Projects 

• Files like Math_Assignment1.docx go in Assignments. 

• Files like Holiday_Photo1.jpg go in Photos. 

• Subfolders allow logical grouping of related files for easier retrieval. 

6. Tips for Effective File and Folder Management 

• Use meaningful names for files and folders. 

• Keep a consistent folder structure across projects. 

• Avoid storing too many files in a single folder. 
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• Regularly review and clean up unnecessary files. 

• Always backup important folders to external drives or cloud storage. 
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Creating Directories and Using Them to Manage Electronic Files 

(K, U, S) 
K – Knowledge 

• A directory (folder) is a container used to store and organize electronic files on a 
storage device. 

• Directories can contain subdirectories, creating a hierarchical structure for better 
organization. 

• Files and folders have names and attributes that help in identifying and protecting 
them. 

• Understanding the importance of directories helps prevent file clutter and data loss. 

 

U – Understanding 

• Directories allow files to be grouped logically, making them easier to find and 
manage. 

• Proper organization improves efficiency, supports backups, and facilitates sharing. 

• Knowing how to create, rename, move, and delete directories ensures effective file 
management. 

• Understanding file paths and directory hierarchies helps in navigating and retrieving 
data quickly. 

S – Skills 

• Creating directories: 

o GUI method: Right-click → New → Folder → name it. 

o Command line: Use commands like mkdir foldername. 

• Managing files: Move, copy, or save files into appropriate directories. 

• Structuring directories: Organize files into main folders and subfolders (e.g., 
Documents → School → Assignments). 

• Practical skills: Renaming folders, changing properties, and maintaining a clear 
folder hierarchy. 
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FILE EXTENSIONS 
1. Definition 

A file extension is a suffix at the end of a file name, usually consisting of three or more 
characters after a period (dot), which indicates the type of file and the program used to 
open it. 

Example: 

• report.docx → .docx is the file extension for a Microsoft Word document. 

• photo.jpg → .jpg is the file extension for an image file. 

 

2. Importance of File Extensions 

1. Identify File Type: Helps the operating system know which application can open the 
file. 

2. Organization: Makes it easier to classify files (e.g., documents, images, videos). 

3. Prevents Errors: Ensures that the correct program opens the file. 

4. Security: Certain file extensions (e.g., .exe) may indicate executable files, alerting 
users to potential risks. 

 

COMMON FILE EXTENSIONS, USES, AND FULL MEANINGS 
File Ext Full Meaning Use / Purpose Example Program 

.docx Document Extended Word processing document Microsoft Word  

.xlsx Excel Spreadsheet 
Extended 

Spreadsheet for calculations, 
tables, charts 

Microsoft Exce 

.pptx PowerPoint 
Presentation Extended 

Slide presentations Microsoft PowerPoint 

.txt Text File Plain text document with no 
formatting 

Notepad, Text Editor 

.pdf Portable Document 
Format 

Document format that preserves 
layout across devices 

Adobe Reader 
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.jpg / 

.jpeg 
Joint Photographic 
Experts Group 

Compressed image file Image Viewers, Paint 

.png Portable Network 
Graphics 

Image file supporting transparency Image Viewers 

.gif Graphics Interchange 
Format 

Animated or static image Image Viewers, 
Browsers 

.mp3 MPEG Audio Layer 3 Compressed audio file Music Players 

.wav Waveform Audio File Uncompressed audio file Music/Audio Players 

.mp4 MPEG-4 Video File Video file format Media Players 

.avi Audio Video Interleave Video and audio container format Media Players 

.mov QuickTime Movie Video file for Apple devices QuickTime Player 

.exe Executable File Program that can run on a 
computer 

Windows Applications 

.html HyperText Markup 
Language 

Web page file Web Browsers, HTML 
Editors 

.css Cascading Style Sheets Stylesheet for web page design Web Browsers, Editors 

.js JavaScript File Script file to add interactivity on 
web pages 

Web Browsers, Editors 

.zip Compressed Archive 
File 

Stores compressed files to save 
space 

WinZip, WinRAR 

.rar Roshal Archive Compressed archive for multiple 
files 

WinRAR, 7-Zip 

 

Notes 

• File extensions tell the operating system which program to use to open the file. 

• Changing a file extension manually may make the file unusable. 

• Common extensions are grouped by type: 

o Documents: .docx, .txt, 
.pdf 

o Spreadsheets: .xlsx 

o Presentations: .pptx 

o Images: .jpg, .png, .gif 

o Audio: .mp3, .wav 
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o Video: .mp4, .avi, .mov 

o Web Files: .html, .css, .js 

o Compressed Files: .zip, 
.rar 

o Executable Files: .exe 

4. Notes / Tips 

• Changing a file extension manually may make the file unusable. 

• The OS often associates file extensions with default programs. 

• Some file extensions are hidden by default in operating systems. 

• Understanding file extensions helps in organizing, sharing, and troubleshooting files. 

 

FOLDER AND FILE SECURITY 
1. Definition 

Folder and file security refers to the methods used to protect files and folders from 
unauthorized access, modification, or deletion. Security ensures that sensitive information 
remains confidential, intact, and available only to authorized users. 

2. Importance of File and Folder Security 

1. Protect Confidential Data: Prevents unauthorized users from accessing sensitive files. 

2. Prevent Data Loss: Reduces the risk of accidental deletion or corruption. 

3. Control Access: Allows specific users to read, modify, or execute files. 

4. Maintain Integrity: Ensures files are not tampered with or altered by unauthorized 
users. 

5. Support Compliance: Helps meet legal and organizational data protection 
requirements. 

3. Methods of Securing Files and Folders 

1. Passwords: 

✓ Protect files or folders by requiring a password to open or modify them. 

✓ Example: Password-protecting a Word document or a ZIP folder. 
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2. File/Folder Permissions: 

✓ Control who can read, write, or execute files/folders. 

✓ Example: Windows allows setting permissions for users or groups (Full Control, Read-
only). 

3. Encryption: 

✓ Converts data into a coded format readable only by authorized users. 

✓ Example: Encrypting sensitive documents so even if accessed, content cannot be read 
without the key. 

4. Backup Copies: 

✓ Store duplicate files/folders in secure locations (external drives, cloud storage) to 
prevent data loss. 

5. Antivirus/Anti-malware Protection: 

✓ Protects files and folders from malicious software that may corrupt or steal data. 

6. Physical Security: 

✓ Secure storage devices (external drives, USBs) in locked locations to prevent 
unauthorized access. 

4. Best Practices 

• Use strong, unique passwords for sensitive files and folders. 

• Regularly update permissions to reflect changes in users or access needs. 

• Encrypt important files to protect sensitive information. 

• Backup critical data regularly to avoid permanent loss. 

• Keep systems updated and secure from malware and unauthorized access. 

 

FILE SAVING 
1. Collaborating to Save Files on Various Storage Media 

• Objective: Learners work together to save files on different storage devices. 
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• Storage Media Examples: 

o USB drives: Portable flash storage, easy to share between devices. 

o External hard drives: Large-capacity storage for backing up multiple files. 

o Cloud storage (optional): Google Drive, OneDrive for online collaboration. 

• Skills Practiced: 

o Inserting devices and recognizing them on the computer. 

o Copying and moving files safely without data loss. 

o Ensuring proper ejection of devices to prevent corruption. 

 

2. Simulating Real-World Scenarios 

• Objective: Learners collaborate to mimic real-world file management tasks. 

• Example Scenario: Storing a client’s project information. 

• Steps: 

1. Create a logical file structure: 

▪ Example: 

▪ Client Project 

▪ ├─ Contracts 

▪ ├─ Reports 

▪ └─ Presentations 

2. Assign files to appropriate folders: 

▪ Contracts → store signed agreements 

▪ Reports → store research findings 

▪ Presentations → store slides for meetings 

3. Ensure proper naming conventions to make files easily identifiable. 
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• Skills Practiced: 

o Planning folder structures. 

o Collaborative file saving and organization. 

o Understanding how real-world projects manage client information. 

3. Individual File Saving 

• Objective: Learners save their own documents in the correct formats and folders. 

• Steps: 

1. Choose the appropriate file format: 

▪ .docx → Word documents 

▪ .pdf → Portable Document Format 

▪ .txt → Plain text files 

2. Select the correct folder in the predefined file structure. 

3. Save with meaningful file names reflecting content or date. 

• Skills Practiced: 

o File format selection for compatibility and purpose. 

o Saving files in structured folders to maintain order. 

o Attention to detail in naming files for easy retrieval. 
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TOPIC 2: ELECTRONIC PRESENTATION DURATION:     32 PERIODS 

 

ELECTRONIC PRESENTATIONS 

An electronic presentation is a digital way of communicating ideas using presentation 
software such as Microsoft PowerPoint, Google Slides, or LibreOffice Impress. It presents 
information in the form of slides that may contain text, images, charts, audio, video, and 
animations. Electronic presentations help make information clear, attractive, and easy to 
understand for an audience. 

A good electronic presentation should be simple, well-organized, visually appealing, and 
interactive. Interactivity keeps the audience engaged and improves understanding. 

 

OPENING MS POWERPOINT 2016 
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MICROSOFT POWERPOINT INTERFACE: 
 

1. Title Bar 

• Located at the top of the window. 

• Displays the name of the presentation and the application (Microsoft PowerPoint). 

• Includes Minimize, Maximize, and Close buttons. 

2. Quick Access Toolbar 

• Usually above the Ribbon (can be moved below). 

• Contains frequently used commands like Save, Undo, Redo, and Print. 

• Can be customized to include your favorite tools. 

3. Ribbon 

• A set of tabs across the top of the window. 

• Each tab (Home, Insert, Design, Transitions, Animations, Slide Show, Review, View, 
etc.) contains groups of related commands. 

• Example: The Home tab has Clipboard, Slides, Font, Paragraph, Drawing, and Editing 
groups. 

4. Tabs 

• Part of the Ribbon. 

• Clicking a tab changes the set of commands displayed. 

• Example: Insert tab lets you add Tables, Pictures, Shapes, Charts, SmartArt, etc. 

5. Slides Pane / Navigation Pane 

• Located on the left side of the screen. 

• Displays thumbnails of all slides in your presentation. 

• Allows you to switch, add, delete, or rearrange slides. 

6. Slide Area / Workspace 

• The central area where you design and edit a slide. 
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• Shows the current slide selected in the Slides Pane. 

• You can add text, images, shapes, charts, and other objects here. 

7. Notes Pane 

• Located below the Slide Area. 

• Lets you add speaker notes for the current slide. 

• Useful for guiding your presentation while speaking. 

8. Status Bar 

• Located at the bottom of the window. 

• Displays information such as slide number, design theme, view options, and zoom 
control. 

• Can switch between Normal, Slide Sorter, Reading, and Slide Show views. 

9. View Buttons 

• Located at the bottom-right corner of the window (on the Status Bar). 

• Quick access to Normal View, Slide Sorter, Reading View, and Slide Show. 

10. Zoom Slider 

• Located on the bottom-right of the window. 

• Allows you to zoom in or out of the slide area for better editing. 

 

WORKING WITH PANES IN MICROSOFT POWERPOINT: 
 

1. What are Panes? 

Panes are different sections of the PowerPoint window that allow you to view and work on 
slides, notes, and other elements at the same time. They make editing and organizing your 
presentation easier. 

2. Common Panes in PowerPoint 

a) Slides Pane / Navigation Pane 
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• Located on the left side of the window. 

• Shows thumbnails of all slides in your presentation. 

• Uses: 

o Select a slide to edit. 

o Reorder slides by dragging thumbnails. 

o Add or delete slides quickly. 

b) Slide Area / Workspace 

• Central part of the window where you edit the current slide. 

• Uses: 

o Add and format text, images, charts, and shapes. 

o Apply design, transitions, and animations. 

c) Notes Pane 

• Found below the Slide Area. 

• Lets you write speaker notes for each slide. 

• Uses: 

o Prepare reminders or talking points for your presentation. 

d) Outline Pane (Optional) 

• Can replace the Slides Pane. 

• Shows slide titles and text in outline format. 

• Uses: 

o Quickly review content. 

o Reorganize text without worrying about design. 

e) Task Pane (Context-Sensitive) 

• Appears on the right for certain features, like animations, formatting, or design ideas. 

• Uses: 
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o Access additional commands and settings without opening dialog boxes. 

 

3. Tips for Working with Panes 

• Resize panes by dragging their borders. 

• Switch between panes using the View tab or keyboard shortcuts. 

• Collapse or expand panes to give more space to the Slide Area. 

• Use multiple panes simultaneously (Slide Area + Notes Pane + Task Pane) for efficient 
editing. 

WORKING WITH MICROSOFT POWERPOINT: 
 

1. What is Microsoft PowerPoint? 

• PowerPoint is a presentation software used to create slideshows. 

• It allows users to combine text, images, charts, videos, animations, and transitions into 
professional presentations. 

2. Starting PowerPoint 

• Open PowerPoint from the Start Menu or desktop shortcut. 

• You can choose to start with a Blank Presentation or use pre-designed templates. 

3. Key Components of PowerPoint Interface 

• Title Bar: Shows the file name and application. 

• Ribbon & Tabs: Home, Insert, Design, Transitions, Animations, Slide Show, Review, 
View. 

• Slides Pane: Thumbnails of all slides on the left. 

• Slide Area: Central workspace to edit slides. 

• Notes Pane: For speaker notes below the slide. 

• Status Bar & Zoom Controls: At the bottom for slide info and zooming. 

4. Creating Slides 
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• Add New Slide: Home → New Slide or right-click Slides Pane → New Slide. 

• Slide Layouts: Choose layouts like Title Slide, Title and Content, Two Content, etc. 

• Edit Content: Add text boxes, images, charts, shapes, SmartArt, and videos. 

5. Formatting Slides 

• Design Tab: Apply themes and slide backgrounds. 

• Format Tab (Picture, Shape, or Text): Adjust style, color, borders, and effects. 

• Slide Master: Change layout or design for all slides at once. 

6. Adding Transitions and Animations 

• Transitions Tab: Add visual effects between slides. 

• Animations Tab: Animate text, shapes, or pictures within a slide. 

7. Working with Panes 

• Slides Pane: Navigate and reorder slides. 

• Notes Pane: Add speaker notes. 

• Outline Pane: View content in text outline format. 

• Task Pane: Access formatting, animations, and design options. 

8. Presenting Slides 

• Slide Show Tab: Start presentation from beginning or current slide. 

• Presenter View: Shows notes and next slides for the presenter. 

• Keyboard Shortcuts: 

o F5 → Start slideshow from beginning 

o Shift + F5 → Start slideshow from current slide 

9. Saving and Sharing 

• Save: File → Save or Ctrl + S (choose .pptx format). 

• Export: Save as PDF, video, or images. 

• Share: Email or upload to cloud storage like OneDrive. 
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       Summary: 
Working with PowerPoint involves creating, formatting, organizing, and presenting slides 
using the interface’s panes, Ribbon tabs, and tools. Mastering panes, slide layouts, transitions, 
and animations helps create professional presentations efficiently. 

 

WAYS TO MAKE AN INTERACTIVE PRESENTATION (WITH 

EXAMPLES) 
1. Use Images and Graphics 

Example: 

• Insert pictures related to the topic (e.g., road signs in a transport presentation). 

• Use icons instead of long text. 

2. Use Animations and Transitions 

Example: 

• Apply simple animations to bullet points so they appear one by one. 

• Use slide transitions like Fade or Push to move between slides. 

3. Insert Charts and Graphs 

Example: 

• Create a bar chart to show transport usage statistics. 

• Use a pie chart to represent budget allocation. 

4. Add Audio and Video 

Example: 

• Insert a short video explaining a concept. 

• Add background audio or narration to explain slides. 

5. Use Hyperlinks and Action Buttons 

Example: 
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• Create a button that links to another slide or a website. 

• Add “Next”, “Back”, or “Home” buttons for navigation. 

6. Include Questions or Quizzes 

Example: 

• Add a slide with multiple-choice questions. 

• Ask the audience a question and reveal the answer on the next slide. 

7. Keep Slides Simple 

Example: 

• Use few bullet points per slide. 

• Use large, readable fonts and consistent colors. 

 

FORMATTING BACKGROUND IN MICROSOFT POWERPOINT: 
 

1. What is Background Formatting? 

• The background of a slide is the base layer behind your text, images, or other content. 

• Formatting the background makes slides more visually appealing and consistent 
with your presentation theme. 

2. How to Format Background 

1. Right-Click Slide → Format Background 

o Or go to the Design tab → Format Background. 

2. Options Available in the Format Background Pane: 

a) Solid Fill 

• Fill the slide with one color. 

• You can adjust color, transparency, and tint/shade. 

b) Gradient Fill 
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• Fill the slide with a blend of two or more colors. 

• You can adjust direction, angle, gradient stops, and transparency. 

 

c) Picture or Texture Fill 

• Fill the slide with an image or texture. 

• Options: Insert picture from file, online source, or clipboard. 

• Adjust transparency to make text readable. 

 

d) Pattern Fill 

• Fill the slide with repeating patterns (dots, stripes, grids). 

• Customize foreground/background colors. 

 

3. Apply to All Slides 

• After choosing your background style, click “Apply to All” if you want the same 
background on every slide. 

• Otherwise, it only applies to the current slide. 

 

4. Tips for Background Formatting 

• Keep contrast between background and text for readability. 

• Avoid overly bright or busy backgrounds that distract from content. 

• Use consistent backgrounds to maintain a professional look. 

       Summary: 
Formatting the background in PowerPoint allows you to enhance slide design using 
solid colors, gradients, pictures, textures, or patterns, either on one slide or 
across the whole presentation. 
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Format Background 

│ 

├── Solid Fill 

│    ├─ Choose color 

│    └─ Adjust transparency 

│ 

├── Gradient Fill 

│    ├─ Choose multiple colors 

│    ├─ Set gradient stops 

│    ├─ Adjust direction & angle 

│    └─ Set transparency 

│ 

├── Picture or Texture Fill 

│    ├─ Insert picture (file, online, clipboard) 

│    ├─ Choose texture 

│    └─ Adjust transparency 

│ 

├── Pattern Fill 

│    ├─ Select pattern type (dots, stripes, grid) 

│    ├─ Set foreground color 

│    └─ Set background color 

│ 

└── Apply Options 

     ├─ Apply to current slide 
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     └─ Apply to all slides 

USING HYPERLINKS IN MICROSOFT POWERPOINT: 
1. What is a Hyperlink? 

• A hyperlink is a clickable link that takes you to another location. 

• In PowerPoint, hyperlinks can connect to: 

o Another slide in the same presentation 

o A website or URL 

o A different document (Word, Excel, PDF, etc.) 

o An email address 

2. How to Insert a Hyperlink 

1. Select the object or text you want to turn into a hyperlink (text box, shape, or 
image). 

2. Go to the Insert tab → Link / Hyperlink (or press Ctrl + K). 

3. In the Insert Hyperlink dialog box, choose the type of link: 

o Existing File or Web Page: Link to a website or document. 

o Place in This Document: Link to a specific slide in your presentation. 

o Create New Document: Link to a new file that will be created. 

o Email Address: Open a new email with a pre-filled address. 

4. Click OK to apply the hyperlink. 

 

3. Editing or Removing a Hyperlink 

• Edit: Right-click the linked object → Edit Hyperlink. 

• Remove: Right-click → Remove Hyperlink. 

4. Tips for Using Hyperlinks in Presentations 

• Use descriptive text for links (e.g., “Visit our website”) instead of raw URLs. 
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• Test hyperlinks before presenting to ensure they work correctly. 

• Combine hyperlinks with action buttons for interactive slideshows. 

       Summary: 
Hyperlinks in PowerPoint allow you to navigate slides, open files, visit websites, or 
send emails directly from your presentation, making it interactive and professional. 

 INSERTING SHAPES, IMAGES, TABLES, AND CHARTS IN 

MICROSOFT POWERPOINT: 
1. Inserting Shapes 

• Purpose: Add visual elements like arrows, rectangles, circles, or custom shapes to 
enhance slides. 

• Steps: 

1. Go to Insert tab → Shapes. 

2. Select a shape from the gallery. 

3. Click and drag on the slide to draw it. 

4. Format: Change color, outline, or add effects via Shape Format tab. 

 

2. Inserting Images 

• Purpose: Add pictures to make slides more engaging. 

• Steps: 

1. Go to Insert tab → Pictures. 

2. Choose the source: 

▪ This Device – from your computer 

▪ Stock Images – free images provided by PowerPoint 

▪ Online Pictures – from the internet 

3. Select the image → click Insert. 

4. Format: Use the Picture Format tab to resize, crop, or apply effects. 
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3. Inserting Tables 

• Purpose: Organize data neatly in rows and columns. 

• Steps: 

1. Go to Insert tab → Table. 

2. Hover over the grid to select the number of rows and columns or click Insert 
Table to enter numbers manually. 

3. Enter data directly into cells. 

4. Format: Use the Table Design and Layout tabs to change style, color, 
borders, and cell alignment. 

 

4. Inserting Charts 

• Purpose: Represent data visually (bar, line, pie, etc.). 

• Steps: 

1. Go to Insert tab → Chart. 

2. Choose a chart type (Column, Line, Pie, Bar, Area, etc.) → click OK. 

3. An Excel worksheet opens → enter your data. 

4. Format: Use Chart Design and Format tabs to change colors, style, and 
labels. 

 

       Tips for All Insertions: 

• Keep slides uncluttered; avoid too many shapes or images. 

• Use consistent styles for tables and charts. 

• Resize objects proportionally to maintain clarity. 

• Use alignment and grouping tools to organize multiple objects neatly. 
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WORKING WITH ADVANCED FEATURES IN MICROSOFT 

POWERPOINT, including SmartArt, Media Clips, Headers & Footers, 

Presentation Views, Slide Master, Slide Show, And Printing: 
1. Inserting SmartArt 

• Purpose: Visually represent information (processes, hierarchies, cycles). 

• Steps: 

1. Go to Insert tab → SmartArt. 

2. Choose a category (List, Process, Cycle, Hierarchy, Relationship, Matrix, 
Pyramid). 

3. Click OK → enter text in the SmartArt graphic. 

4. Format using SmartArt Design and Format tabs. 

 

2. Inserting Media Clips 

• Purpose: Add audio or video to make slides interactive. 

• Steps: 

1. Go to Insert tab → Audio or Video. 

2. Select source: 

▪ Audio: Record, online audio, or file. 

▪ Video: Online video or file from device. 

3. Insert and adjust size/position. 

4. Use Playback tab to set start options, volume, and trimming. 

 

3. Headers and Footers 

• Purpose: Add consistent information like date, slide number, or notes on slides. 
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• Steps: 

1. Go to Insert tab → Header & Footer. 

2. Choose what to include: 

▪ Date and Time 

▪ Slide Number 

▪ Footer Text 

▪ Don’t show on title slide (optional) 

3. Click Apply (current slide) or Apply to All (all slides). 

 

4. Presentation Views 

• Purpose: View and edit slides in different layouts. 

• Types: 

o Normal View: Default editing view (Slides Pane + Slide Area + Notes). 

o Slide Sorter View: Displays all slides as thumbnails for easy rearranging. 

o Reading View: View slides as a slideshow within PowerPoint window. 

o Slide Show View: Fullscreen presentation mode. 

o Notes Page View: View slide with speaker notes. 

 

5. Slide Master 

• Purpose: Maintain consistent design and layout across all slides. 

• Steps: 

1. Go to View tab → Slide Master. 

2. Edit the master slide (background, fonts, colors, placeholders). 

3. Close Master View → changes reflect on all slides. 
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6. Slide Show 

• Purpose: Present your slides professionally. 

• Steps: 

1. Go to Slide Show tab. 

2. Options: 

▪ From Beginning (F5) 

▪ From Current Slide (Shift + F5) 

▪ Set Up Slide Show → select show type, timings, or loop. 

3. Use Presenter View to see notes and upcoming slides. 

 

7. Printing Presentation 

• Purpose: Produce hard copies of slides or handouts. 

• Steps: 

1. Go to File → Print. 

2. Select printer and settings: 

▪ Print slides full page or as handouts (1, 2, 3, 6 slides per page). 

▪ Include notes pages if needed. 

▪ Choose color, grayscale, or pure black and white. 

3. Click Print. 

 

       Summary: 
These features help make your presentation interactive, professional, and consistent: 

• SmartArt & Media Clips: Visual and audio enhancements 

• Headers & Footers: Consistent information on slides 

• Slide Master & Views: Efficient editing and uniform design 
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• Slide Show & Printing: Presenting and distributing slides 
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TIPS FOR MAKING A GOOD PRESENTATION IN MICROSOFT 

POWERPOINT OR ANY SIMILAR TOOL: 
1. Plan Your Content 

• Define the purpose of your presentation. 

• Organize information in a logical order: Introduction → Main Points → Conclusion. 

• Keep slides focused on key ideas, avoid overloading with text. 

2. Design Slides Effectively 

• Use consistent theme and colors. 

• Limit fonts to 2–3 types; ensure they are readable. 

• Use contrasting colors for text and background for clarity. 

• Avoid clutter—leave enough white space. 

3. Use Visuals Wisely 

• Include images, charts, tables, SmartArt to support points. 

• Avoid irrelevant or low-quality visuals. 

• Use icons and symbols to emphasize ideas. 

4. Keep Text Short and Clear 

• Use bullet points instead of long paragraphs. 

• Each slide should cover one main idea. 

• Avoid reading directly from slides; use them as guides. 

5. Apply Animations and Transitions Moderately 

• Use subtle transitions between slides. 

• Animate objects only if it adds value, not for decoration. 

• Avoid distracting or flashy effects. 

6. Prepare Speaker Notes 

• Use the Notes Pane to write talking points. 
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• Include key facts, examples, or reminders for speaking. 

7. Practice Delivery 

• Rehearse the presentation multiple times. 

• Check timing to stay within the allocated slot. 

• Practice speaking clearly and confidently. 

8. Engage Your Audience 

• Ask questions or encourage interaction. 

• Maintain eye contact and observe audience reactions. 

• Use pauses for emphasis and clarity. 

9. Check Technical Aspects 

• Test projector, screen, and sound if using media clips. 

• Ensure hyperlinks, videos, and animations work properly. 

• Save a backup copy on USB or cloud. 

10. Print or Share Handouts 

• Provide handouts for detailed notes or data if needed. 

• Use condensed slides or notes pages to save paper. 

       Summary: 
A good presentation is clear, concise, visually appealing, and engaging. Focus on 
content, design, and delivery, and always practice beforehand. 

 

FORMATTING PRESENTATIONS FOR VISUAL APPEAL AND 

ENGAGEMENT (USV APPROACH) 
1. U – Understanding 

Focus: Making content clear and easy to understand. 

• Slide layout: Use simple, uncluttered slides with one idea per slide. 
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• Text: Short, concise sentences; bullet points instead of paragraphs. 

• Visuals: Add relevant images, icons, or diagrams to illustrate ideas. 

• Example: For a topic on “Climate Change,” use a diagram showing rising temperatures 
instead of paragraphs. 

 

2. S – Skills 

Focus: Enhancing your audience’s skills through interaction. 

• Charts & Graphs: Visualize data for better comprehension. 

• Interactive elements: Include polls, questions, or short activities. 

• Highlighting: Use color, bold text, or animations to emphasize key points. 

• Example: In a business presentation, include a simple graph for “Sales Growth” and ask 
the audience to interpret it. 

 

3. V – Values 

Focus: Conveying ethical, cultural, or motivational values. 

• Quotes & Stories: Add inspiring quotes or short real-life stories. 

• Images: Use visuals that resonate emotionally with your audience. 

• Design choices: Maintain professional and respectful design; avoid clutter or 
distracting colors. 

• Example: In a leadership presentation, include a slide with a quote from a respected 
leader and a related image. 

 

Additional Tips for Visual Appeal 

• Consistent design: Same font, color scheme, and layout throughout. 

• Readable fonts: Titles (36–44 pt), Body (18–24 pt). 

• Contrast colors: Light background with dark text for clarity. 
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• Engaging visuals: Use diagrams, charts, infographics, and icons. 

• Minimal animations: Only subtle transitions like Fade or Push. 
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     Summary Table (USV Approach) 

USV Component Key Focus How to Apply in Presentation 

U (Understanding) Clarity of content Simple slides, bullet points, diagrams, 
relevant images 

S (Skills) Practical engagement Charts, interactive questions, highlighting 
key points 

V (Values) Emotional & ethical 
connection 

Quotes, stories, images, professional design 
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TRIAL ACTIVITIES OF INTERGRATION 
 

1. NATIONAL DIGITAL TRANSFORMATION 

The government is implementing a National Digital Transformation Strategy to modernize 
service delivery across all sectors. Stakeholders require a professional presentation to explain 
how ICT contributes to national development and policy implementation. 

Task 

Using presentation software, design a presentation titled: 
“ICT as a Driver of National Digital Transformation.” 

Requirements: 

• Minimum 10 slides 

• Analyze ICT applications in education, health, governance, finance, transport, 
agriculture, security, and business 

• Evaluate benefits and challenges in at least four sectors 

• Insert two charts comparing traditional vs ICT-based systems 

• Include interactive navigation buttons 

• Apply consistent professional design 

• Save appropriately 

2. DIGITAL LEARNING SYSTEMS 

A national curriculum body is introducing blended and online learning systems at advanced 
level institutions. 

Task 

Create a presentation titled: 
“Advanced Digital Learning Systems in Education.” 

Requirements: 

• At least 9 slides 
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• Explain LMS platforms, virtual classrooms, and digital assessment tools 

• Compare traditional vs e-learning using a chart 

• Insert images and short explanatory notes 

• Include hyperlinks to learning resources 

• Apply subtle animations suitable for academic presentation 

3. ICT IN HEALTHCARE MANAGEMENT 

A health policy conference requires a presentation analyzing the impact of ICT on healthcare 
management and service delivery. 

Task 

Prepare a presentation titled: 
“ICT in Modern Healthcare Management.” 

Requirements: 

• Minimum 9 slides 

• Analyze electronic health records, telemedicine, and health information systems 

• Include a chart showing improvement in service delivery 

• Evaluate ethical and security concerns 

• Add interactive elements linking to case studies 

4. ICT AND ENTREPRENEURSHIP 

A youth innovation summit is focusing on how ICT supports entrepreneurship and digital 
startups. 

Task 

Design a presentation titled: 
“ICT as a Catalyst for Entrepreneurship.” 

Requirements: 

• At least 9 slides 

• Analyze ICT tools used in marketing, accounting, and e-commerce 
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• Include a chart showing business growth trends 

• Evaluate advantages and limitations of digital business 

• Use interactive navigation and hyperlinks 

5. DIGITAL BANKING AND FINANCIAL TECHNOLOGY 

Scenario 

A financial technology (FinTech) forum requires an analytical presentation on the evolution of 
digital financial services. 

Task 

Create a presentation titled: 
“ICT in Digital Banking and Financial Technology.” 

Requirements: 

• Minimum 9 slides 

• Explain ATMs, online banking, mobile money, and blockchain concepts 

• Compare traditional banking vs digital banking using charts 

• Analyze security risks and mitigation measures 

• Include interactive content 

6. INTELLIGENT TRANSPORT SYSTEMS 

Scenario 

A transport planning authority is adopting Intelligent Transport Systems (ITS) to improve 
efficiency and safety. 

Task 

Prepare a presentation titled: 
“ICT in Intelligent Transport Systems.” 

Requirements: 

• At least 9 slides 

• Analyze GPS, traffic monitoring, and automated ticketing 
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• Include charts showing traffic efficiency improvements 

• Evaluate challenges such as cost and infrastructure 

• Apply professional animations and interactive navigation 
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7. ICT IN AGRICULTURAL TECHNOLOGY 

Scenario 

An agricultural research institute is promoting smart farming technologies. 

Task 

Design a presentation titled: 
“ICT in Smart Agriculture.” 

Requirements: 

• Minimum 9 slides 

• Analyze ICT tools in weather forecasting, precision farming, and market access 

• Include charts showing productivity changes 

• Evaluate benefits and constraints faced by farmers 

• Add interactive links to research data 

 

8. E-GOVERNANCE AND DIGITAL PUBLIC ADMINISTRATION 

A public administration seminar is discussing the transition to digital governance systems. 

Task 

Create a presentation titled: 
“ICT in E-Governance and Public Administration.” 

Requirements: 

• At least 9 slides 

• Analyze e-services, digital records, and online participation 

• Include charts comparing service delivery efficiency 

• Evaluate transparency, accountability, and data security issues 

• Add interactive navigation 

9. ICT IN SECURITY AND CYBER SAFETY 
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A national security workshop requires a presentation on the role of ICT in modern security 
systems. 

Task 

Prepare a presentation titled: 
“ICT in Physical and Cyber Security.” 

Requirements: 

• Minimum 9 slides 

• Analyze CCTV, biometrics, and cybersecurity tools 

• Include charts showing crime reduction or threat trends 

• Evaluate ethical and privacy concerns 

• Include interactive elements 

10. ICT AND ENVIRONMENTAL SUSTAINABILITY 

An international environmental forum is addressing the use of ICT in sustainable 
development. 

Task 

Design a presentation titled: 
“Role of ICT in Environmental Sustainability.” 

Requirements: 

• At least 9 slides 

• Analyze environmental monitoring systems and data analysis tools 

• Include charts showing environmental impact trends 

• Evaluate benefits and limitations of ICT solutions 

• Add interactive navigation and references 
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TOPIC 3: COMPUTER HARDWARE   DURATION: 28 PERIODS 
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